2021 Year End Summary

USE AND DISTRIBUTION NOTICE

e Santa Clara County RACES authorization is granted to use and
duplicate this material as-is as long as this page and the
copyright notices on each page are included, acknowledging
Santa Clara County ARES/RACES as the holder of the
copyright.

e Permission is granted to adapt this presentation to your
needs as long as you acknowledge our copyright and include a
note similar to "adapted with permission from Santa Clara
County ARES/RACES”

¢ For additional information on training or any of our programs
send an email to: info@scc-ares-races.org
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Agenda

¢ Packet Update

e October Exercise and SET
e October Exercise Packet Operations

¢ Net Control Updates
e Message Passing
e BBS, Network Update

e New FCC Station Evaluations

¢ Volunteer Hours Reporting

e 2022 Training
e Credential Program
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Packet Update

Jim Oberhofer, KN6PE Packet Exercise

Revised 01-Dec-2021

Weekly Packet “Practice” Weekly Packet “Practice”

2021... by the numbers (7-Dec-2020 thru 30-Nov-2021) ¢ See the “Standard Packet Check-In/Out Message” App Note

nder...
© Monday Tuesday 21t ‘20t ‘19w ‘18wl N

https://www.scc-ares-races.org/data/packet/index.html#app-notes
Ttl Practice Messages sent 1365 1861 3226 3138 2844 2116

¢ See the Practice Message, Subject section under...

PR — ey ey e o 03.2% https://www.scc-ares-races.org/data/packet/weekly-packet-
’ ’ : practice.html#Message

Unique Ave # of

31 29 255
Participants/Night & & &
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What's new with
Outpost and PackltForms

SCCo Installer v160
July 2021

PackltForm 3.2.1*

Digitally signed PackltForm installer and programs
No functionality changes

Outpost v3.5.0*
Digitally signed Outpost installer and programs
Minor functionality changes to address SCC
defects

*See the release notes for details

11
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What's in the box?

e SCCo Integrated Packet Installer 160

e Outpost Packet Message Manager
— GUI-based interface for managing packet communications
— Makes using packet as simple as using e-mail

e PackltForms
— Next generation HTML-based forms for use with Outpost
— Headless Chrome for auto-printing support

e PacFORMS
— HTML-based forms for use with Outpost

— Since 2007, simplified forms-based data entry, reduced network
bandwidth

10

What was new, differentin 20217

12
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Top 7 packet “what’s new” items for 2021

. Packet Training on Zoom

. Windows 11

Event Documentation

. Check-in, Check-out messages

. Resend Options (and the Subject Line)
. Manual Packet (and the Subject Line)
. Packet as a repeatable process

BN WS U N

13

7. Another year on Zoom
Packet training in pajamas

e Ran all the packet classes by zoom

e Zoom registration helped track who actually showed up

e Office Hours offered a chance for troubleshooting, 1-on-1 chats, and
general Q&A

e Updated homework assignments

e Completing the homework was prerequisite for class credit

— Packet IllA; Outpost and PackltForms 79%
— Packet I1IB; Applying packet to the Field 94%
— Packet Il; What!? No Outpost? Manual Packet 68%

14

6. Windows 11

e Windows 11 was released on October 5, 2021
— Price: Free upgrade for existing Windows 10 users

— new desktop look, a major Ul redesign, changes to the core Microsoft
OS apps and services.

— Microsoft says Windows 11 was built for gamers.
e But... not every Windows 10 PC is Windows 11 compatible

¢ The good news: PackltForms and Outpost works fine on W11

e SCC RACES packet PC recommendation:
— Laptop or larger netbook running at least Windows 8.1
(end of W8.1 extended support... January 10, 2023)

15
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5. Event documentation
Its all about the money

e Excerpts from the FEMA | Office of Inspector General report titled “Summary of
Key Findings of Fiscal Year 2016 FEMA Disaster Grant and Audits”

« “Over the 7-year period, FYs 2009 to 2015, we found $1.64 billion, or 15 percent, in
questioned costs out of the $10.9 billion that we audited, which we recommended FEMA
disallow as ineligible and unsupported costs.”

* “In fiscal year 2016, we found $155.6 million, or 23 percent, in questioned costs out of the
5686 million that we audited, which we recommended FEMA disallow as ineligible and
unsupported costs.”

* In cases where FEMA payments were made and claims later disallowed, recipients
would be required to repay these payments, with audits sometimes taking place
years later.

* Because your documentation could be a used as part of the City’s justification for
either an expense reimbursement or cost recovery request, ensuring the accuracy
and completeness of what we submit is critical.

16
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5. Event documentation
Its all about the money

Sl

R

FEMA

i

Excerpts from the FEMA | Office of Inspector General report titled “Summary of
Key Findings of Fiscal Year 2016 FEMA Disaster Grant and Audits”

* “Over the 7-year period, FYs 2009 to 2015, we found $1.64 billion, or 15 percent, in

questioned costs out of the $10.9 billion that we audited, which we recommended FEMA
disallow as ineligible and unsupported costs.”

“In fiscal year 2016, we found $155.6 million, or 23 percent, in questioned costs out of the
5686 million that we audited, which we recommended FEMA disallow as ineligible and
unsupported costs.”

In cases where FEMA payments were made and claims later disallowed, recipients
would be required to repay these payments, with audits sometimes taking place
years later.

Because your documentation could be a used as part of the City’s justification for
either an expense reimbursement or cost recovery request, ensuring the accuracy
and completeness of what we submit is critical.

How does this apply to us?

If tracked properly, hours worked volunteering can be reimbursed by FEMA
under the guidelines for “volunteer labor” (44 Code of Federal Regulations (CFR)
13.24 (c) (1)).

The reimbursement rate would depend on the volunteer and the type of work
completed.

The reimbursement rate could be in the range of $20 to $50 / hr (estimate)

For instance:

Your_ARES 10 10 # volunteers

Hrs / day 12 120 Volunteer hours / day
Days / event 10 1200 Volunteer hours / event
$/hr $35 $42,000 Reimbursement

And... city staff hours are reimbursable if overtime is extraordinary or the work is
not normally budgeted in their job.
BUT, it all depends on getting the documentation right.

17
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What can go wrong... a case in point

From May 1 through May 2, 2010, Tennessee experienced high winds
and flooding which resulted in widespread loss of power.

The disaster forced residents to vacate their homes and to require food
and basic housing.

The Applicant opened a disaster recovery center and staffed it with
volunteers.

The Applicant requested credit toward the calculation of the non-
Federal cost share for volunteer labor, donated equipment, and
donated materials.

FEMA initially granted Applicant’s request for a $65,416 credit but later
de-obligated $57,714 because volunteer hours were not properly
documented.

Archiving event documentation
Introduction

During a Packet Deployment, you will produce the following:

1. ICS 214-SCCo Unit Activity Log
ICS 309-SCCo Communications Log (if participating on a voice net)
All third party sent & received PackltForms and plain text messages
All sent and received operator to operator packet messages
ICS 309 Communications Log (packet)

A

Any Form 1 / hand-scribbled / sticky notes, documentation.

Applies to exercises and real activations

When your shift is over, your supervisor will tell you what to do, such as:
— Submitting all documentation (to whom and how)
— Preparing the packet station for the next use (archiving your shift)

19
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Event documentation

QO
Introduction \

¢ The job is not done until the paperwork
is complete, archived, and submitted.

— Every scrap of paper used during an activation is part of the event or
incident and goes to the Documentation Unit (or your Supervisor)

¢ It must be legible (print)
e Use one side only
— These are legal documents that may be needed to defend decisions
— Most of this documentation is ‘discoverable’
— Ifitis not in the documentation, then it did not happen
— Some documentation is specifically created after the event or
incident, such as the After Action Report

¢ And, all this applies to our packet operations

I8l Printable Message Listing2.txt - Notepad
2. Create a printable message listing [Fie tan formar view Heip
. started =
a) From OUtPOStx File > Save All. to smell gas outside my house and\nthink it iq
. " hous=
b) Creates an Ascii-formatted file e. -- pPeople Trapped: negative\nLast Seen:n/a
of all messages in the current folder DEVDHEIGONT
. DATM=211120 0849
with a Page Break between each EVNT=BVD21324.102
message. 1/ADDON |
c) Repeat for any other folder where From:  kjeoht@lxsc.ampr.org
To: CUPEOC; KJI6OHT
event messages were stored. sent:  11/20/2021 09:01
n . . Subject: OHT-225P_R_Downed Tree KJG0HT BVD
d) This file could be printed to generate ? =
-N-| The earthquake brought down a tree at the end
one messa?ge per page or cut-n paSte blocking the road. cars cannot pass. Some neig
out a specific message. clear it.
e) Deliver this file to your supervisor. | ocation: o puddling stoen Way, Cupertino, crof
Pacifica.
Reported by: Lou Grant, 21603 La Playa Ct, 408
From: kjéoht@wixsc.ampr.org
To: CUPEOC
Sent: 11/20/2021 @9:10
R i
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Archiving event documentation

1. Create the ICS 309 Communication
Log

a
b

- =

C

-~

d
e

- =

ICS 309

COMMUNICATIONS LOG

[arsar fr

Outpost, Forms > ICS 309 Comm Log.

Select Period Tab, then Range for when
your shift (or event) occurred.

Select Output Tab, then which printer

NOTE: If you do not have a printer, then select
the Microsoft Print to PDF printer to produce a
.pdf file.

Press Build Data Set, then press Print.

If you paper-print this form, then sign the
ICS 309.

Deliver this report to your supervisor.

[asvrogas [T
vorevrogw

S——

s |everos

22

Archiving event documentation

a)

b)

C

-

BB Outpost Packet Message Manager
3. Create a Message Archive Fie | Edn Sewp Tools

New Message
From Outpost, File > Export, then Save As..
select “All Folders* (for your entire i
system). Expont

Impeort
Use meaningful file names. Move to Folder..

Copy to Folder...
The Export process will create an e
Outpost Archive File (.oaf). Prin.

Print. No Headers...
This file later can be imported back Print Setup.

d

=

e

Forms  Actions Help

culeN | print | SenaRecene | Prof
Cules
>
>
[ WIXSC1
ALL K6FB.2
CireP ALL K6FB-2

into Outpost to restore the archived
messages to their original folders.

Deliver this file to your supervisor.

24
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Archiving event documentation
iy

4. Reset Outpost for the next event
a) You are about to DELETE ALL MESSAGES in Outpost

Do not proceed until you have created a
Message Archive>All Folders first.

Do not proceed until you have
permission from your supervisor.

b) Make sure you set up the SCC Notices message folder

c) Export (backup) the SCC Notices folder (File > Export...)

c) Delete all Outpost messages (File > Delete All Messages, Yes)
d) Restore the SCC Notices (File > Import...)

e) You now have a clean system for the next event or incident.

f) Inform your supervisor that this task is complete.

o

4. Check-In/-Out Messages

¢ Properly formatted Check-In/Out messages are important
— Recipient can easily find them among other messages in the In Tray
— They inform the EOC or other “net control” which stations are ready
— They are part of DSW supervision

*aGeneral rules during field assignments
'\f‘»‘)} — Check in and out using your assigned Tactical Call, not your FCC call
— Check-in as soon as the station is ready
— Check-out before shutting down the station using your Tactical Call
— Always send as plain text messages (not forms)
— Always use [HandlingOrder] =“_R_"
¢ Handling Order = R (Routine)
— Always follow the standard subject line format
¢ With specific check-in/out details for subject and message body

25

Check-In/-Out: Tactical

e Tactical Check-In Format:
— Subject: [MsgNbr]_R_Check-In [TacticalCallSign], [TacticalName]
— Body: Check-in [TacticalCallSign], [TacticalName]
Present are:
[List of FCC call signs and full names, one per line]

e Example:
— Subject: SH1-234P_R_Check-In XNDSH1, Xanadu Shelter 1
— Body: Check-in XNDSH1, Xanadu Shelter 1

Present are:
WG6XRL4, Herman Munster

e Check-Out format is the same, except replace “Check-In"” with “Check-Out”

https://www.scc-ares-races.org > Data Networking > Packet BBS > Standard Packet Check-In/Out Message

27
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26
Check-In/-Out: Individual
¢ Unless your local jurisdiction requires it, it is unlikely you will
need to use an individual check-in/out. But, if you do...
¢ Individual Check-In Format:
— Subject:  [MsgNbr]_R_Check-In [FCCCallSign], [FullName]
— Body: Check-in [FCCCallSign], [FullName]
e Example:
— Subject:  XRL-123P_R_Check-In W6XRL4, Herman Munster
— Body: Check-in W6XRL4, Herman Munster
e Check-Out format is the same, except replace “Check-In” with
“Check-Out”
28
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3. Message Resend

You did what?!!?

¢ You just sent a message, but ...

— it was addressed incorrectly, or

it was incomplete, or

it was the wrong message, or

it was sent to the wrong BBS, or
you forgot to include all recipients, or

— any number of other problems!

And, you don’t want to type it all back in! What now?

29

Resend option — Text Messages

Resend a message previously

sent.

e Sent folder, open the message

e Actions > Resend... choose
option

e Edit the message.

File Edit Actions Window Help

I 6PE-1754P - outpostpm test (PM:1649)

File Edit View | Actions Windows Hely

Prinl | Reply Reply Cad
Private Message s

Bbs: W')‘S{? Forward

From  KNEPE Set to Unread

To. KNGPE L Resend ) Same Message ID
subect BPE-17  AddAddre New Mezsage D

! CUP-280R_R_Check-out CUPEOC, Cupertino EOC - Packet Messac

Popup Menu

e For Resend, Same Msg ID _Seng | _Pomt | Save |Dolete| Ciose | urg| P
’ ’
Private M

manually change the Message ID dicuochsiin'as

from -###P to -###R for Resend. = | ahiata

= = = From [CUPEOC

e Make whatever other changes To.. [[XSCEOC
you need to make, then Subject: [CUP-280R_R_Check-out CUPEOC, Cupertino EOC

e Press Send, then Send/Receive.

Check-out CUPEOC, Cupertino EOC
Present are:
KNEPE Jim Oberhofer|

e P P

Resend Options (and the Subject Line)

¢ Three types of Message Resend
1. Text Message, same Message ID or new Message ID
2. PackitForm Message , same Message ID
3. PackltForm Message , different Message 1D

31
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30
Resend option — PackltForm Messages
Same Message ID...
Resending PackltForm Messages = .0
. - Receive Oni
depends on your option. = — =
¢ Sent folder, single-click on the message 3 A trma e L0 FETR R
FIREED - i s achansed g el ;

to highlight it (not open it) [ f omemmn e ms v
« Actions > Open enhanced msg as text  ‘u] AN o s R,:;:;:,',ff
e Once the text opens, click on Actions >

Resend... choose Same Message ID Santa Clara County EOC Resource Re|

. Message Numbers: : -

e PackltForm opens a new copy in the = :ﬂ:;"m:s °"::::—-=—i:“ ——

Browser, ready for editing. 105 Posttion: Logiaties
¢ Manually change the Message ID from 7 Location: [scc eod

-###P to -###R for Resend. g tore:

— Contact Info:

¢ Make other changes and continue as e

usual. Earthquake, Day 2

5. Requested by (name, agency, position, email, phone)
Copyright © 2021 Santa Clara County ARES®/RACES. Al rights reserved
32
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Resend option — PackltForm Messages
New Message ID...

BB Report Setings

Get the Next Message Number:

— In Outpost, Tools > Report Settings

— Note the Next Message value. This is
the number to use. Do not change it!

Variables | Reports | 103309 |

Glonal Variables.

Report Vanables, this profile

Organization: [Cupertino Cinze

Sent folder, single-click on the message tg
highlight it (not open it)

City. [City of Cuperting

Actions > Open enhanced msg as text

Once the text opens, click on Actions >

Message Numbers:  Origin: cuP-321P
Resend... choose New Message ID

The PackItForm will open in the browser. ICS Position: DEC

Manually change the PackltForm Origin i

Location: SCC QEC

. Name:
message number with the number you G
noted above. 1. Incident Name

Earthquake, Day 2

Make other changes and continue as usual. : :
5. Requested by (name, agency, position, email, phone)

Submit to Outpost | Submit via Email| Reset Form | |
Santa Clara County EOC Resource Rej

——
Date: Time: 89:17 Handlin

33

2. Manual Packet (and the Subject Line)

e Without Outpost, you have to manual
Message ID tracking. One method: Xanadu Fire Station 14
Manual Message ID List

e Any piece of paper will do.
Herman Munster, W6 XRL4

e Create a list of message IDs to use.

— Use the ‘M’ suffix to indicate this is — 30—
—— I
a Manual message and not conflict 202/

= X14-303M
X14-304M
X14-305M

with Outpost’s ‘P’ (for packet) suffix.

e When you use one, cross it out.

» Example: given this list, your next X14-306M
Message ID is X14-303M. | X14-307M

» For packet messages sent or received, | X14-308M
enter the Message ID in the next

X14-309M
message; don't forget your ICS 309. :

34

1. Packet as a repeatable process

¢ Packet 3A — Packet systems and tools
— Packet Network Overview and Components
Packet Station HW & SW
— Accessing the network
— Standard workflow
— Working with messages

e Packet 3B — Applying packet to a field deployment
— Customizing message handling
— Miscellaneous Outpost settings
— Localizing packet
— Simulated field message exchange

* Packet 2 — Advanced Packet
— Manual packet messaging

35
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Thinking in terms of a Packet Field Deployment

1. First Shift... when assigned to start up a station

2. Initial station setup... equipment check-out

3. Packet Operations... managing the message flow

4. Incoming Shift Change... if you are relieving someone else
5. Outgoing Shift Change... if you are being relieved

6. Securing Operations... when directed to shut down

36
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1. First Shift
Packet Field Deployment Process

1. First Shift: Establishing a packet station

1. Inform Resource Net Control that you have arrived. Check out of
the Resource Net before you leave your car.

2. Check into the assigned voice net before you leave your car.
Start an ICS 309 Comm Log for the voice net.

Make an ICS 214 Unit log entry.
Sign in on the site’s ICS 211 Check-in sheet.
Find the supervisor and inform them of your arrival.

Request a safety and assignment briefing; get details on any site-
or event-specific conditions that exist. You need to know:

o0k w

ST

Band and frequency
Primary and secondary packet addresses for any
preferred destinations

7. Find and establish the workspace to set up packet operations.

a. Supervisor's Name

b. Activation Number

c. Operational Period

d. ICS Location

e. Your Tactical Call and Message ID Prefix
f. BBStouse

g.

h.

2. Initial setup
Packet Field Deployment Process

2. Initial setup: Equipment check-out
. Find, assess, and setup the packet radio equipment
v 8. Find d th ket radi i
(see Section 3, Packet Startup Procedure)
9. Confirm or set your User Identification (FCC Call Sign) and
Tactical Call for the assigned agency.
10. Check settings before transmitting:
Correct BBS in Outpost
Correct Interface in Outpost
Correct radio frequency

11. Begin packet operations. Make ICS 214 Unit log entry.

NN

37
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3. Packet Operations
Packet Field Deployment Process

3. Packet Operations: Managing the message flow

12. Download all notices to ensure you have the latest; read them.

13. Set up a folder named “SCC Notices” (Tools > General Settings,
Startup tab) and move all notices to this folder.

14. Send a test message to yourself to confirm you can create, send
to, and receive from the assigned BBS.

15. Create a Check-In message to your assigned agency using your
Tactical call sign (see Section 5 Check-in, Check-out Message).
16. Send, receive, log and process packet messages. To only send a
message as soon as it is created, use Actions > Send Only
17. Manually initiate an Outpost Send/Receive at least every 10
minutes.
18. If a message was not acknowledged:
a. Check the message address and BBS
b. Resend the message if needed
c. Let your supervisor know

NNNNNN

... more

3. Packet Operations (continued)
Packet Field Deployment Process
3. Packet Operations: Managing the message flow
v 19. If new notices are retrieved, follow any new instructions.
20. Maintain voice radio contact on the designated voice net.
21. Make ICS 214 Unit log entries as appropriate.

22. Report any issues or problems to your supervisor in person or
over the voice net (if remote).

39
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v/

24.
25.
26.

27.

28.
29.

4. Incoming Shift Change
Packet Field Deployment Process

4. Incoming Shift Change: If you are relieving someone else, do the following:
23.

Inform Resource Net Control that you have arrived. Check out of
the Resource Net before you leave your car.

Sign in on the local ICS 211 Check-in sheet.
Find the supervisor and inform them of your arrival.

Request a safety and assignment briefing; get details on any site-
or event-specific conditions that exist.

Find the person you are relieving and receive a shift change
briefing (see Shift Change Information below).

Make packet system updates — Station ID, Tactical Call, etc.
Make all relevant shift change entries in your ICS 214 Unit log.

41

5. Outgoing Shift Change
Packet Field Deployment Process
5. Outgoing Shift Change: If you are being relieved, do the following:

When contacted by your replacement, provide a shift change

Generate and sign a packet ICS 309 Comm Log for your shift.

Generate all event packet documentation for your shift and deliver
as instructed (see Section 8 Archiving Event Documentation).

Turn over all assigned equipment to your replacement.
Find your supervisor and inform them of the shift change and your

Make the appropriate shift change entries in your ICS 214 Unit

30.
briefing (see Shift Change Information below).
v 31.
VAR
33.
34.
departure.
35.
log. Complete and sign the form.
36. Turn in all paperwork to your supervisor.
37. Sign out on the site’s ICS 211 Check-in sheet.
38.

Check into the Resource Net. Inform Net Control what you plan to
do (go home, return to EOC, etc.).

T R

39.
40.

41.
42.

43.
44,
45.
46.
47.

6. Securing Operations
Packet Field Deployment Process

6. Securing Operations: when directed to shut down, do the following:

Get permission from your supervisor to shut down.

Create a text Check-Out message to your assigned agency using
your Tactical Call sign (see Section 6 Check-in, Check-out
Message).

Generate and sign a packet ICS 309 Comm Log for your shift.
Generate all event packet documentation for your shift and deliver
as instructed (see Section 8 Archiving Event Documentation).
Complete and sign your ICS 214 Unit log.

Shut down and pack up all assigned equipment.

Turn in all paperwork to your supervisor.

Sign out on the site’'s ICS 211 Check-in sheet.

Check out of the assigned voice Net and check in with the
Resource Net. Inform Net Control what you plan to do or where
you will go.

42

Amateur Packet Radio

43
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Field Reference (unofficial)
What is it

Provides a reminder (job aid) for
how to perform tasks that need
to occur during a packet field
deployment.

Helps ensure task consistency,
completeness, and operational
alignment with SCCo RACES
policies and procedures.

What it is not

the only source of information on
which you should rely.

an official SCCo RACES
deliverable.

(the unofficial)
Amateur Packet Radio
Field Reference

For SCCo RACES Responders

October 2021

@

b

44
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Amateur Packet Radio
Field Reference (unofficial)

1
H

CoNoohe

|Table of Contents

QUICK REF E
INTRODUCTION

21 Pussose Where to find it...

g:g g?:guusnmsﬂmomnx‘.....,..‘.‘.,......‘..........‘.,....‘.‘...... https://bit ly/PacketFieldRefFull (.pdf)... great
B OPTRATOR CHECKLIST. ¢ for storing on your laptop or tablet.
B b s https://bit.ly/PacketFieldRefBooklet (.pdf)...
T A formatted to create an % size booklet; just
ARCHIVING EVENT DOCUMENTATIO 1 print, fold, and staple in the middle.

9.1
9.2
93

9.4
10 M

101
10.2
10.3
104
10.5
10.6
10.7

IANUAL PACKET

Create THE ICS 309 CoMMUNICATION LOG.
CREATE A PRINTABLE LIST OF YOUR MESSAGES
CREATE AN ARCHIVE OF YOUR MESSAGES .......
ReseT [cLEaNUP) OUTPOST FOR THE NEXT EVENT

Or contact knbpe@arrl.net

TNC Commanps
BBS COMMANDS
CoNNECTING TO YOUR TNC cuvvei e

StarT o SHIFT: Conrigure TNC SeTTiNGs ..
Eno OF SHIFT: Restore TNC SeTring
SenoinG PackiTForms .
Receving PackltForms

45

A look at DIY KPC-3 alignment

Ensuring your TNC-Radio is properly
set is critical to packet operations.
This includes both Receive Volume
and Transmit Level.

The KPC-3x Manuals are good at
describing what to do but lack an
end to end description of exactly how this is to be done.

Being able to make these settings is critical to Packet field
operations.

What’s the plan for 20227

¢ Maintenance release planned

— Fix reported bugs; Outpost enhancements, PackitForm enhancements

* Pop-up Packet Exercise

— 30-Apr-2022
—  8-Oct-2022

¢ Packet class schedule
— Packet Type lIA  6-Aug-2022
— Packet Type llIB 1-Oct-2022
— Packet Type Il 5-Nov-2022

And, new class content, such as...

Copyright © 2021 Santa Clara County ARES®/RACES. All rights reserved
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A look at DIY KPC-3 alighment

e Setting the Transmit level — you will need:
— The latest KPC-3x manual for reference.
— AKPC-3x to calibrate.
— An HT to receive the transmitted CAL signals.

— A dummy load (While not required, it is always
good not to splatter your calibration tones all
over the airwaves).

— A smartphone app such as Decibel X
to display the audio.

e Watch for a details in 2022 on a DIY
approach to setting the transmit level.

48
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For More Information

e Support
— See the Santa Clara County ARES/RACES web site packet page
e https://www.scc-ares-races.org/data/packet/index.html

— Join the packet discussion group

* Practice
— Send a message during the weekly packet net, either or both days
e https://www.scc-ares-races.org/data/packet/weekly-packet-practice.html

e Automated feedback to help you improve, verify you've got it right
— Participate as a packet operator at drills and other events

49

Drill Summary

* Deployment Drill Exercise, minimal info was given
to participants

* Travel to location and set up, be prepared to
operate and conquer the unknowns

* “Dress Rehearsal” before incident deployment

* Same location as 2019 with activities FieldOps,
NetControl, PacketOps and Shadowing

51
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Countywide Drill and SET
October 09, 2021

Andreas Ott, K6OTT
Revised 11-Dec-2021

50

More drill stats

Day of drill: ~ 250 person hours on 1CS-211

* Preparation: estimated ~ 300 person hours

* Post-processing of paperwork and evals: 100 hours
* Ratio of participants to staff is only 3:1

52
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Drill Feedback
Packet messaging throughput outpaced voice
about 8:1! Thank you, Mark!
We will use more Outpost scripting in the future
Quality of submitted documents is going up
Timing of shifts and spacing of exercises (MSEL)
Equipment problems at netcontrol (radio trailer)

Intermod (frequencies) and fundamental overload
(radio hardware quality)

Evaluations at drills: delays and problems removed
required activities, evaluators in double-duty roles

Preliminary ARRL SET report 2021

e 42 participants (incl. 1 visitor, 1 remote)

¢ Of these were 13 new hams, licensed 2017 or later
* 2 message nets, command net, packet + voice net
* 25 voice messages (?), 198 packet messages (!)

e 17 "agencies” EOCs, shelters, rovers, packet

e 12 “jurisdictions” Xanadu plus participating cities

* All stations on emergency power

e At least 723 points total, maybe some more

53
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October Communications Drill
and SET

Packet Operations Observations

Mark Laubach, K6FJC
Revised 24-Nov-2021

55
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Packet Operations Summary

e 2 shifts, 7+ 5 = 12 simulated shelters

e Automated EOC Outpost Script drove messaging passing
Task Groups

e 2 P2 evaluations, 8 P3 evaluations conducted
e 193 messages passed (not including Delivered receipts)
e Time performance overview (in minutes) highly variable:

1 12 13 14 15 16 17 21 22 23 24 26
Check-In delta . . y - . . . . . . . .
T 00:57 01:14 00:43 01:34* 00:28 00:19 01:05 00:43 00:45 00:57 00:37 00:16
Immediate
received from 00:36 00:17 00:49 00:32 00:11 00:26 00:39
Check-in
Check-Out delta
from Check-in

%‘;C:;‘i?(u;;ﬂ‘a 02:11 02:09 01:48 02:11 02:02 02:08 02:17 02:39 03:13 02:01

00:39 00:29 00:31

01:28 00:35* 01:20 01:52 00:57 01:25 01:32 01:42 02:36 01:45

* First check-in message was sent at 0:34, but not properly formatted

56
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Packet Operations Future Drill Considerations

¢ Increase training/emphasis on pre-event preparation
— Each participant needs to understand their set-up time for time mgmt
— Also, hopefully can reduce set-up time

e Expect some "checklist education” on pre-operation readiness
— What needs to be done before Check-In
¢ When the exercise follows a “deployment” scenario:
— Defining a “shift” for packet didn’t work out as expected
¢ Highly variable set up times
* Management was not practicing “good” time management
— Expect an “operational period” to be defined within a Shift
¢ Model a served agency’s operational period requirements

* Packet stations must be ready to go with Check-in at the start and will be
closed down at the end

* Each participant will need to plan accordingly lead-time and tear down

Monthly Packet Message Passing Practice

¢ The Outpost script-driven messaging passing automation
worked well during the October exercise

e We are going to trial a monthly packet message passing
practice on December 15, Starts at 09:00 on Wednesday the
15th and ends on 17:00 on Wednesday the 22",

— Zoom “office hours” on the evening of Wednesday the 22",
¢ Participants will need to sign up for the SCC Event
— Those that sign up will be assigned a tactical ID and ICS location
¢ This first trial will be a modified re-run of the SCCo exercise
Message passing task group from 9 October
* Intent is to exercise 3" party and operator-to-operator
messages following a different scenario each month

— Keep it interesting and non “cut and paste”

58

57
Net Control Training for 2022
Type lll Part A& B
Type ll
Mark Laubach, K6FJC
Revised 24-Nov-2021
59
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Plans for 2022

¢ Continued emphasis on pre-class homework

— Expect updated course materials one week before class

— Homework will likely be moved to a separate handout / presentation
e Typelll Part A

— Add focus on pre-assignment readiness and planning

— May include a new checklist or two...
e Typelll Part B

— Focus will remain on operating, but some added emphasis on process
flow (hint: checklist)

e Typell
— Rebalance of homework versus class material
— Will try to develop additional class participation exercise(s)

60
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Message Passing

Tim Howard, KE6TIM
Revised 04-Dec-2021

61

* Message Handling Procedures
were updated based on:

o Observations during drills,
events, and credential

. Santa Clara County ARES®/RACES

evaluations

o Feedback from this years
two Message Passing
Classes

Message Handling
Procedures

o Discussions with our
message passing team.

Revised: 15-November-2021

Class Changes

* Added a homework component to class with a review

during the first part of the class using message samples:

http://bit.ly/Med-Base
https://www.pge.com/en_US/safety/

The P/N is 5bcDEw

Meet at 37° 22’ 13.97” N, 122° 02’ 24.56” W
ICP located at 37 22.2328, 122 02.4093
107A E 1st St Apt 3C

O O 0O 0O o0 O

* Added Unknown Symbol/Character

» Added Superscript/Subscript

+ Clarified other procedures to eliminate confusion and
ambiguity

62
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Copyright© 2021 Santa Clara County ARES/RACES. All Rights Reserved.

Unknown Symbol or Character

e Example:
- Written: Send 50 Z today
- Spoken: “send FIGURES fife zero <pause> UNKNOWN SYMBOL
<pause> today”
The receiver draws an empty box on their message form where the
unknown symbol would appear.

Send 50 [ today
e Example:
o Written: We can use ab§6 instead
o Spoken: “We can use MIXED GROUP alpha bravo UNKNOWN
SYMBOL UNKNOWN SYMBOL <pause> instead”

We can use ab[][] instead

64
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SUBSCRIPT and SUPERSCRIPT

Used to indicate the following character should be written a half-line
lower (SUBSCRIPT) or higher (SUPERSCRIPT) than the rest of the text,
such as subscripts and mathematical exponents

Used with one character at a time

Does NOT remain in effect until the end of the group

Examples:
. Written: White blood cell count is 10°

. Spoken: “white blood cell count is FIGURES one zero
SUPERSCRIPT fife”

o Written: Model XS4,

. Spoken: “model MIXED GROUP x-ray sierra four SUBSCRIPT six
SUBSCRIPT tree”

SUBSCRIPT and SUPERSCRIPT

¢ When given a chemical symbol to send, if possible, ask the message
author to provide the common English word for the chemical.
If that is not possible, then use the procedure outlined above.

* Written by message author: H,0,

Corrected by message author:+4585 Hydrogen Peroxide

¢ Spoken: hydrogen peroxide (you might use | SPELL here to ensure
precise copy

65
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INITIAL(S)

Identifies one or more letters to follow
Used for non-word letter groups
Voice each letter phonetically
Leave a pause after the last letter to help separate it from groups
that follow
Use for letter groups such as Initials, Abbreviations and Acronyms
Is immediately followed by white space or a punctuation mark .,:;!?

These are Initials
o ARRL

o St.

o Dr.

o EOC

o CA

o T. (AsinJames T. Kirk)

67

Copyright© 2021 Santa Clara County ARES/RACES

. All Rights Reserved.

FIGURE(S)

Identifies one or more numerals to follow
* Voice each digit separately
* If anything, other than a numeral is present, it becomes a

MIXED GROUP, MIXED GROUP FIGURE(S), or MIXED GROUP SYMBOL(S).

¢ These are Figures
o 145
o 35
o 13253

* These are NOT
o -145 (Mixed Group Symbol)
13,253 (Mixed Group Figures)
2/3 (Mixed Group Figure)
146.595 (Mixed Group Figures)
408.555.1212 or 408-555-1212 (Telephone Figures)

O O O O

68
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Symbols

Some symbols have context sensitive names

[
&

Dong [ [voems |

decimal (in numbers), or ampersand < less-than-sign
dot (in email, packet, and T
. Ifternet addresses); or *  asterisk |3 <
period (end of sentence and Ve _ underscore
elsewhere)
\ backslash | vertical-line
7 comma
. ., seconds (in GPS coordinates), A caret|careet|
: colon
double-quote (elsewhere) ~ iide kil deei
; semi-colon apostrophe (within a word),
5 «+  minutes (in GPS coordinates), | | o :
Qquestion-mark <
? uestion-mark St la=anobe degree-sign (elsewhere)
1 exclamation-point 5
- - HASCHIIN Voicings are shown in bold.
minus-sign (in numbers), _si|
- hyphen Iﬁn i,n,ds e L 2| pereent sin Voice hyphenated words as if they
dash (elsewhere) (  left-parenthesis are a single-word.
+ plus-sign ) right-parenthesis Punctuation symbol voicings are
underlined.
= i left-square-bra
Snusteien [ Rlafe-eguane Bincha Contextis shown in italics.
Ll 11} Aeishicocrusng; brackst \ Pronunciation \ is between
#  pound-sign { left-curly-bracket backslashes.
$ dollar-sign }  right-curly-bracket

69

APPENDIX B - Summary of Prowords used in Message Passing

ROGER
BREAK

STAND BY

Control Prowords

Define the start, end, or control the flow of the message.
MESSAGE NUMBER

CONTINUE or GO
NEWLINE

END OF MESSAGE or MESSAGE ENDS.
SAY AGAIN or SPELL (PHONETICALLY)

Clarification Prowords

AFTER a group. ol
ISPELL
1SAY AGAIN

Qualification prowords

'UPPERCASE and LOWERCASE
SUBSCRIPT and SUPERSCRIPT

Introductory Prowords

BEFORE Alerts

INITIAL(S)
FIGURE(S)
SYMBOL(S)

‘TELEPHONE FIGURES
GPS COORDIANTES.
AMATEUR CALL
EMAIL ADDRESS
PACKET ADDRESS
INTERNET ADDRESS.

to use each proword in inside, or after a group) to

sag

Recommended St Clra O Shep s — e
Field Groupings — ]
© Msg Nbr, Date, Time, Handing
o To, From Date: Fipaiin Sandiog: Opioc Oouting (231
© Report Type, Shelter Name - “::I:M : |me:M
o Then go section by section © [ Name: 0 [ Name:
& Say section name Comact M | comctinto:
o Say field name(s) and value(s) fapsrilims: Ouednie Ocompiots | gy i
o Shoot for about 5 items Shelter A Type
(fields/groups) at a time shatier Type: _(pickons) _ Otyped Oz 0 Orypes
o Skip empty fields & sections :'::::" P00 Oopiklieni (Ochiviing Orie
[ Longtude aassr:
See examples of the
other forms in Appendix A
of the Message Handling L —
ety oo v One
Procedures document AT et O Oe
MN!}NM(DMMI!:
Floorplan (where/how sent}:
70
wmion ] ‘
Form Updates e - -
> oy o 1 i Sy
ICS 214 and ICS 309
revised to add a . —
. o g
signature block ‘
| | N\ |
! | "‘/‘ N\ . |
[ (T FY bare_i_
1G5 2145CC0 ARES/RACES (EV.W
rsces
mnces From:
PTG
1 o
I
| e
7 N
& Preparsd By (Nam, Call Sign) |6A. Signature. ')l"\m Propared ;."‘_“_

105 308-50C0 ARESIRACES (Rev. 2021-A01.08)
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SCCo BBS System update

Andreas Ott, K6OTT
Revised 11-Dec-2021

Accomplished in 2021

* Slowly emerging from Pandemic restrictions: we
were able to access field sites during second half of
year

* Replaced 3 of 4 BBS computers with new
hardware, virtualized BBS servers, backups

* Monitoring of network and power status

* Minor device and component maintenance,
software upgrades

73

Plans for 2022

Finish hardware replacement of BBS computers
Plan for firewall replacement

Add subscriber stations (at EOCs, hospitals)
Plan for County EOC relocation ~2024

Software improvements (servers and JNOS) — Big
Thanks to Thomas KK6FPP and John W6JMK

Possible automation of Practice Packet NetControl

74

Changes to FCC

Station Evaluation Rules

Yes, you need to do an
RF Safety Evaluation

Andreas Ott, K6OTT
Revised 11-Dec-2021

Acknowledgement: Morris Jones, AD6ZH
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Before
RF Safety Evaluation
* License requires evaluation Band |Power| Band |Power
* FCC Bulletin OET 65 160m |SO0W| #m |50 W
Appendix B is written 80 |@po”| 2m [sow
specifically for hams 1 00 |1.25m|sow
* Keep human exposure b 425 | 70em | 70w

specified levels (24-?‘ 20 | 225 | 33 | 150
Table shows vaidation 17 125 | 23 | 200
is required 6 15 100 13 250
. Powerkve?includes both 12 75

transmitter power and

isotropic gain of antenna 10m |50W
— Dipole => 2.15dBi

Before
From OET Bulletin 65 Appendix B...

* VHF/UHF - Less than 50 watts radiated. no evaluation needed

» Safe exposure distance from the antenna for 50
transmitter and different antennas from Byllefin 65 (worst
case), watch for magmount on top of car@$§0 Watts

‘0 [ (dBi) | (feet)

1442m)| 3 | 106

6 | 149
22(125m) 3 | 106
6 | 149
450 (70cm) 3 86
6 | 122

77
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FCC Rule and Order 19-126
Effective May 2021

* From ARRL ARLBO11:

The new rules do not change existing RF exposure (RFE) limits but do require that
stations in all services, including amateur radio, be evaluated against existing limits,
unless they are exempted. For stations already in place, that evaluation must be
completed by May 3, 2023. After May 3 of this year, any new station, or any
existing station modified in a way that's likely to change its RFE profile - such as
different antenna or placement or greater power - will need to conduct an
evaluation by the date of activation or change.

* https://docs.fcc.gov/public/attachments/FCC-19-126A1.pdf
(159 pages, contains submitted comments, and math)

But how?
ARRL web pages (info, FAQ, calculator)

http://www.arrl.org/rf-exposure

http://www.arrl.org/rf-exposure-calculator
QST article September 2021, pp. 60-62

To get proof of evaluation: do it on ARRL web
calculator, and then print to PDF and save file

Controlled and uncontrolled exposure (have
different maximum permissible exposure limits),
you want to note the two distances for your setup

79
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And why would you care?

* RF energy gets absorbed into your body. It heats

up tissue over time, and the more you transmit. It’s
accumulative, unless you let your tissue cool down
in between transmissions (duty cycle).

Human body is most susceptible to 30-300 MHz

Controlled (your and your household) versus
uncontrolled exposure (bystanders) have different
maximum permissible exposure limits.

81

For which stations?

All stations! The way | read the R&O, this applies to
your home station or your EOC, and you have until
May 2023 to comply if you have had that station
without changes since before May 2021, but it also
applies to stations we (temporarily) set up in the
field for drills and exercises, and after you make a
change to any station.

So, what are the new safe
distances?

It depends, they are the same as the old safe
distances, but no more easy tables for lookup, and
you will be surprised by what “used to be safe”

Calculation is somewhat involved, as the rules are
based on field strength and power density, two
parameters not easily accessible; and dependent
on the transmit frequency

Variables to be filled in: transmitter power,

feedline loss, antenna gain/loss, frequency,
emission mode and transmitting duty cycle

82

83

Copyright© 2021 Santa Clara County ARES/RACES. All Rights Reserved.

Easy to understand principles

Use low(er) power, as you should anyway

Keep radio antenna away from body when feasible,
or keep body away from radio antenna (heh)

Let body cool down, exponential decay, take
breaks in between transmissions (lower duty cycle)

Keep transmissions short, efficiency as a goal

Check common use cases: body-worn radio,
magmount antenna on car roof, pushup mast

Use conservative defaults as input

84
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Auxiliary documents

¢ Radio, antenna and feedline datasheets

* The ARRL calculator has a references, also to the
math and code they use

* The former OET Bulletin 65 and Supplements have
not been updated since the R&0O became the law
and are still “under review” iwpsmwicesovseneralioet-butetins e

85

Live demo of ARRL calculator

RF Exposure Calculator

87
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ACAUTION

N

Radio frequancy fialds beyond
this poirt may oxceed the FCC

Bayond this point:

exposure.
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EC Reports
2021 Volunteer Hours
Andreas Ott, K6OTT
Revised 11-Dec-2021
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Overview 2021
. Monthly EC Report Submittal Dashboard for the Year 2021
* First 7 months:
Year to Display: 2021 v/

Agency Jan Feb Mar Apr May Jun Jul Aug Sept Oct Nov Dec

89 reports 20000
County of Santa Clara 90 00O
, Cupertino 20000

* 4 recent months: 20000
Hospitals 90 000
Loma Prieta 290 00O

66 reports - R
Los Gatos/Monte Seren 090 Q900Q
Milpitas report Q0 00O
Morgan Hill 90000
Mountain View sy Stem 920 00O
NASA/AMES 0 000
Palo Alto 00 000
San Jose 90000
Santa Clara City 29 00 0O
sartoga 9 00O
Stanford University 90 00O
Sunnyvale Q90 000

89

Data entry

4

* Thank you for submitting reports and “activating’
hours to be counted

* We will backfill data Jan-Jul 2021 by January, so
that a full report will come out of the new system

* Please be patient and do not enter old data on

your own, but go back and check (update?) when
we tell you that it’s ready

Preliminary stats 2021

e Jan—Jul 2021: approx. 8,133 hours

* Aug— Nov 2021: approx. 5,264 hours

¢ Dec 2021 estimate: 1,100 hours

* Year 2021 summary: approx. 14,500 hours *

(Yes, there were more activities since July after
restrictions were lifted, but we also think we are
captioning more hours and more accurately through
better reporting.)

* The equivalent of $ 2.175 M at minimum wage

91
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2022 Training
Judy Halchin, KKBEWQ
Revised 3-Dec-2021
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2021 Review 2022 — What to expect

Another good year for Gumby

All the regular classes were offered

Watch your email and the sign-up
pages
Full slate of classes scheduled

Zoom-to-classroom transition
* Plenty of masks and plenty of space

* Largest classes stayed on Zoom

Packet practice and mini-drill = April 30

Field Operations classes over the air

Annual drill September 17 — mark your
calendar

Online class evaluation forms

93 94

Clarification of Requirements

¢ To earn a Credential, participation in Training Classes, Exercises,
and Public Services events must be completed within two years.

e Participation in Exercises and Public Service events can not be used
for more than one credential. For example: if a Public Service event

Cred e ntl a I S is used for your C4, it can not also be used for an F3 Credential. A

different Public Service event is required.

e Participation in an activity must be in the same role as the
credential it is being applied to. For example: if you are working on
a P3 Credential, the duties you performed at the activity must be
Tim Howard, KE6TIM packet-related. Working as a Field Operator will not satisfy the
Revised 30-Nov-2021 requirements for a Packet P3 Credential.

e Participation must be at a credential-approved activity.

95 96
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Clarification of Requirements

e Equipment checks are good for one-year. For example: if you
completed an F3 equipment check, you can use that for an N3
within one year and do not need to repeat the equipment check.

e Where equipment requirements are different, you would only need
to have the additional equipment checked.

¢ Radio familiarity and Knowledge tests are also valid for one year.

« Again, where requirements are different, only the additional
requirements would need to be done.

Clarification of Requirements

¢ To maintain Credentials, you must
o Take part in two credential-qualified activities (exercises,
events, incidents) within each two-year period
o Or take part in one credential-qualified activity and at least one
“End of Year Summary’ class within a two-year period.

* Failure to do so will result in loss of Credentials. We made an
exception for 2020 but will be looking at participation again moving
forward.

* There is a reinstatement process outlined in the “Credential
Program Handbook” that can occur within two years of losing a
Credential.

97
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COVID - Credential Requirement Extension

1 Two year period

First canceled class was March 7, 2020
First canceled drill was March 21, 2020
First canceled public service event was Apnl 25, 2020

Activities (Drills, Training, Public Service) resumed July 1, 2021.

99
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Q&A

All Training Staff
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Thank You!

Please check your email and follow the instructions to
complete and return the Course Evaluation.

If you have questions or feedback about this or other training
activities, you can join our Training discussion group.
https://scc-ares-races.groups.io/g/training
This is a moderated group.

See you at a training class or exercise next year!

101
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